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About Organizer Pro
ORGANIZER PRO is a powerful Notary Signing Order and Contact Management Sys-
tem developed using FileMaker Pro. The system is designed to help you manage day to
day tasks within a service oriented business, with a strong emphasis on signing orders
and billing. The modules that make up the system are outlined below. Please note when
you installed the run-time version, the file names will end with the extension‘USR’.

Home.USR

Archive_.USR

Planner.USR

Company_.USR

Contact_.USR

Employe_.USR

FrmLett_.USR

Help_.USR

Invoice_.USR

Letters_.USR

LineItm_.USR

Paymnts_.USR

Project_.USR (Signing Orders)

Terms_.USR

Time_.USR (Billing Entry)

ToDo_.USR

BACKUP

COMPRESS

Archive_.USR

• Invoiced billing records are stored in this template;

Planner.USR

• A calendar template for organizing and planning appointments;

Company_.USR

• Used to record information for your Clients;
• Extensive searching, sorting and reporting capabilities;
• Print labels and envelopes.

Contact_.USR

• Used to record information for your Contacts;
• Extensive searching, sorting and reporting capabilities;
• Print labels, envelopes and letters.

Employe_.USR (Notaries)

• Used to store Notary information;
• Accessed through the Home file.
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FrmLett_.USR

• Various form letters are stored in this template.

Help_.USR

• An on-line help file;

Home.USR

• Used as the home base to access all other templates;
• Access your Company, Notary, and Financial  information;

Invoice_.USR

• Enter and print invoices;
• Enter multiple payments;
• Aged receivables;
• Sales analysis reports.

Letters_.USR

• Create and save boiler plate letters;
• Create letters for as many Contacts as you like with only two clicks;
• Access any of the letters from the Home menu;
• Use the optional Office Memo or Fax layouts.

LineItm_.USR

• This template is used by the system to generate line items in the Invoice file. You
never actually see this template, as it works behind the scenes as part of the
system.

Paymnts_.USR

• This template is used by the system to generate payment items in the Invoice file.
You never actually see this template, as it works behind the scenes as part of the
system.

Project_.USR (Signing Order)

• Signing Orders status reporting;
• Current billing status and Invoiced billing;
• Signing Order List.

Terms_.USR

• Used to store the payment terms offered to clients;
• Accessed through the Home file.

Time_.USR (Billing Entry)

• Billing recording;
• Client Billing Report;
• Resource Billing Report.

ToDo_.USR

• To do list in priority order;
• List of what’s due in the next week.
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Who can benefit from Organizer Pro?
Organizer Pro is extremely useful and time saving for the Mobile Notary and Signing
Agent providing mobile notary signing services. The time you will save each month by
using the signing order & billing features of Organizer Pro is enough to justify its cost.
Owners of OrgPro4 notaries will save hundreds of hours of time by not having to create a
database from scratch.

Designed to automate and streamline any office environment, Organizer Pro 4.0 for
notaries focuses on the six most common business activities which include Contact
Management, Invoicing, Project/Signing Orders, Billing Entries, To Do Lists and Letter
Writing. Since each screen shares common characteristics, the system is easy to use and
easy to master, from input of Company/Contact information to Signing Order and Billing
entries, to the final Invoicing. You can easily follow your clients with Marketing, To Do
Lists, and Letter Writing with standard form letters available, and customizable too. You
also have the options to memo, fax and e-mail. With great reporting capabilities, sorting
and finding is a snap. Need to find just one client or a group to mail to?  With Organizer
Pro 4.0, it only takes a moment to complete. In addition, OrgPro4 notaries ships with a
comprehensive Notary User Manual and Guided Tour.
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Organizer Pro 4.0 for Notaries

User Version
• Includes FileMaker Pro User. You don’t need your own copy of FileMaker Pro

to run this version.
• One user license.
• Password protected. You cannot modify field definitions, scripts and layouts.
• Includes Guided Tour in electronic format.
• Includes Notary User Manual.

What You Need

Windows 95, 98 or later

• PC capable of running Windows 95, 98 or later with at least16Mb RAM;
• Hard disk with 12Mb free;
• 15" Monitor (800 x 600 pixels) or larger in size.

Macintosh

• Power PC Macintosh, 16Mb RAM;
• Hard disk with 12Mb free;
• System 7.6.1 or later;
• 15" Monitor (800 x 600 pixels) or larger in size.

About the Demo

This demo of ORGANIZER PRO has the following restrictions:

• You will not be able to create or edit scripts, define fields or revise layouts.
• It is IMPORTANT to note that new records added to the database are not

permanently saved. You will be able to input into this database for 30 days
ONLY.

Included on the Demo
• 1 ‘OrgPro4 notaries Demo’ installer application
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Installation Instructions
Windows

1. Click on the OrgPro4 notariesDemo.exe icon on the notary-services.com web site.

2. “File Download” pop-up window appears. Select “Save This Program to Desktop”,
click ‘OK’ .

3. The next pop-up window for “Save As”  appears. A file name is created or you can
type in a file name, then click ‘Save’. Saving to desktop is  pre-selected, but if you have
another place you save your files, select that file and then click ‘Save’.

4. A pop-up screen appears, showing that the file is being saved to your desktop. Click on
the ‘Close’ button when complete.

5. Double click on the “OrgProNotaryDemo” icon. A pop-up window for installing the
program appears. Read instructions and click ‘Next’ to continue.

6. Next, the “Installation Folder” pop-up window comes up. Read and make your selec-
tion of file location for installation. Click ‘Next’.

7. The “Shortcut Folder” window is next. Read and use if desired. Click ‘Next’.

8. “Ready to Install” window appears next, read and click ‘Next’.

9. “Installing Files” window appears and starts loading files. After installation is com-
pleted, click ‘Finish’ .

Macintoch

1. Click in the OrgPro4 notariesDemo.hqx icon on the notary-services.com web site.

2. The “Download Manager” starts loading the Demo program

3. The icon for the “OrganizerProNotaryDemo” appears on your desktop. Double click
on the icon, and on the pop-up window, click ‘Continue’.

4. Use the name given for the file or rename it to your choice of file name and click
‘Save’.

5. Another pop-up window says, “Download was successful”, Click ‘Quit’ .

Deletion of Records

Please note that in this demo version any new records added by you are DELETED when
your 30 day time limit has expired.

Renaming Files

Please do not rename any of the files included with Organizer Pro Demo. There are
internal links between files and renaming will corrupt these links.
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Starting Organizer Pro
After installation, the following files should be inside the ‘OrgPro4 notaries Demo’
folder;

• Archive_.USR, Planner.USR, Company_.USR, Contact_.USR, Employe_.USR,
FrmLett_.USR, Help_.USR, Home.USR, Invoice_.USR, Letters_.USR,
LineItm_.USR, Paymnts_.USR, Project_.USR, Terms_.USR, Time_.USR,
ToDo_.USR, BACKUP and COMPRESS folders. Also find Extensions, Solu-
tions and the OrganizerProNotaryDemo folder.

• Guided Tour in PDF format is a  separate download.
• Notary Users Manual in PDF format is another download.

You have the Run-Time version.  The files will have the extension .USR and will also
include the OrganizerPro application. The Windows95/98 Run-Time also includes these
files;

• FM Pro 6.0 and System Folder.
• Guided Tour in PDF format is a  separate download.
• Notary Users Manual in PDF format is another download.

Because some of the ORGANIZER PRO files link information in other files, you should
not change any of the file names. If you do, the files will not function properly and you
will get messages prompting you to locate the linked files.

You can rename the ‘Notary OrgPro4 notaries Demo’ folder if you wish but you should
ensure that all the files are kept together in the same folder because of the links that are
built into the system.

To start ORGANIZER PRO double click on ‘OrganizerProNotaryDemo’ application.
Don’t be alarmed if there is a delay the first time it runs, as some set up is required.

The demo comes with a set of sample files. Please note that if you modify any of the
sample records you may not get the same results as documented here.

I Hate Reading Manuals

While Organizer Pro for notaries is easy to use we recommend that everyone reads and
follows this Guided Tour. Nothing here is rocket science, but the only way to get knowl-
edgeable about this software is to read and follow this Guided Tour. Sorry, it’s the only
way.

We make the assumption that you know how to use your computer. We will try to pro-
vide just the information you need and not bore you with too many details.
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Organizer Pro Interface
ORGANIZER PRO is designed for monitors 15 inches or larger in size. If your monitor
is smaller than 15 inches in size then you will need to use the scroll bars to view the
entire layout. All of the files in ORGANIZER PRO share a common interface and are
consistent in their design. This section will focus on some of those common design
elements.

File Buttons
The rectangular shaped boxes located on the Home Menu are called file Buttons. These
buttons appear only in the Home.USR file and by clicking on these buttons you can easily
move to any of the files within the system.

Clicking on any of these buttons will take you to the appropriate section
in the program, for example, clicking on Companies will take you to 
the Company section of the program.
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Record Buttons
These 4 buttons are located in the top right corner of most layouts and resemble direc-
tional arrows. They allow the user to move between the first, previous, next and last
records in the database.

Layout Buttons
The Layout Buttons are a common feature of the system. A file can have many different
layouts (screens) and usually a layout contains related information, e.g. marketing infor-
mation or financial data.

Once you have opened a file you can easily move to any of the layouts within the file,
simply by clicking the appropriate button.
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Card Tabs
When you click on a Card Tab it changes the view of related information. Tabs are de-
signed so that common information is always visible while the information on the card
can change depending on the tab that is clicked.

Marketing

Function Buttons
When you click on a Function Button it performs a specified task. Function Buttons
generally change from file to file and can also change from layout to layout to accommo-
date that layout’s specific requirements.

Report Buttons
These buttons allow you to print pre-defined reports and vary from file to file.
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Sorting Records
Layouts that display lists of records usually allow you to sort the records by clicking once
on the column labels. The buttons below are from the Project_.USR file (Signing Orders).

Company Name

Status

These buttons are used for sorting. For example, clicking on the Company Name button
will sort the list of clients you are viewing alphabetically.

Marking Records
Many of the layouts that display lists of records allow you to selectively mark individual
records by clicking the Mark check box positioned to the left of each record (see below).
Buttons to find marked records and un-mark records are also positioned on these layouts.
This capability allows you to find any set of unrelated records and perform some action
with those records only, e.g., print envelopes, labels or send a letter.
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List Views
Any list view in Organizer Pro, whether it’s on a card or a full screen, has the ability to

go to the detailed screen when you click on the line of the record you want to see. The

only part of the line that will not do this is on the left edge around the Mark and Omit

icons (for full screen list views).

The Return Button

In the above illustration, the user has clicked on the contact “Christopher Smith”. The
user will then see the detail screen for this contact. To return to a contact’s Company
screen, the user can click on the icon shown below. This return button will return the user
from a child record to its related parent record.

Field Titles

Field Titles that are underlined enter data into that field automatically. For instance, a title
for a date field would enter the current date into that field. Field titles on a Find screen
will bring up an index dialog to show you all the words or entries that exist for that field
in the whole database. The example below which is underlined is for a FIND Company
Name.
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Guided Tour
This Guided Tour gives you step-by step instructions for completing specific tasks within
the Organizer Pro system.

Throughout the Guided Tour your fictional company will be ‘Mobile Notary Services’
and you will be the company Owner, Russ Miller. Having just purchased or downloaded
a DEMO copy of Organizer Pro you are ready to begin working with the database.

Remember that the Help screen is always accessible by clicking on the blue question
mark. It’s a good idea to go to this now and familarize yourself with this HELP AREA .

The OrgPro4.0 for Notaries Demo has all of the files previously mentioned.  When you
open the file you want to double click on the HOME.USR icon.  This takes you to the
‘Home Menu’ screen and this is were you start and when you want to end your ‘Guided
Tour’ this is the screen you come back to and close using the“Quit”  button.

Setting up your Company Information
Click once on the Setup button on the bottom of the HOME.USR File to access the
Company Setup screen. There are 5 tabs showing; Address, Financial, Notary Public and
2 named Future Use (these are customizable in the Developer version of Organizer Pro).
You can access each of these tab or card layouts by clicking on its name.

Address Card (steps 1 thru3 below have already been completed)

1. Press Tab and type your company name, ‘Mobile Notary Services’
2. Press Tab and type the company address, ‘401 Main Street’
3. Tab forward to enter the following information ‘Los Angeles, CA 90001, 213-

555-1212, the fax number 213-555-1213’ and e-mail mns@aol.com.

Financial Card

1. Click on the tab ‘Financial’. For our Guided Tour purposes we will charge no
tax.  Any company offering services ONLYare exempt from charging tax for
their services, in most States.

2. Put in your Social Security number or TIN number (this has already been com-
pleted for the ‘Guided Tour’).

Notary Card (steps 1 thru3 below have already been completed)

1. Click on the tab ‘Notary’. Add the name of ‘Mobile Notary Services’ company
notary ‘Russ’.  Click on the title “Notary List” to add another blank field. Type
the name ‘Kathy’. Now type in the name ‘George’.  He is an outside independent
contractor that is used by this company.

2. Repeat the process for your notaries (if any).  Since this layout allows you to add
an unlimited list of names, you can return to this tab later to enter any other
notaries working for or with the company.

3. Click the Home button at the top right to go back to the Home Menu.
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Adding a New Company
Having just returned from a successful meeting with a new client, ‘ABC Signing Service’,
you begin by adding the company to your database and recording some important facts
about your new client. The company owners are David Shannon and Sheila Eldon.

1. From the HOME.USR File click the Companies Button to move to the Com-
pany Profile Layout.

2. Click on the New Function Button on the right of the layout.
A Dialog Box appears asking whether you are entering a Company or an Indi-
vidual. Click on the Company Button to open the ‘New Company Entry’. From
here enter the company name, ‘ABC Signing Service’ and tab to next field.

3. Select ‘Mr’ from the pop up list in the Salutation field.
4. Enter ‘David’,‘ Shannon’, ‘President’. In the ‘Contact’ field enter ‘Client’ , then

in the ‘Catagory’ field enter ‘Signing Service’. If you are going to be invoicing
the Company or Client that you are currently inputting, you need to select ‘Cli-
ent’ in the ‘Contact Type’ field.

5. Tab forward to enter the billing address as ‘123 North Blvd., Los Angeles, CA
90001', and ’555-1222  and ‘555-1223’ in the appropriate boxes. And finally the
e-mail address davidshannon@home.net.

6. Click OK to view the Company Profile for your new client, ‘ABC Signing
Service’.

The Company Profile
The information you just entered now appears in the Company Profile for ‘ABC Signing
Service’. The 5 Information Cards on the bottom half of the Company Profile will allow
you to add the important information about ‘ABC Signing Service’ that you were able to
find out during your meeting with the company owners.

The Contacts Card
1. The information you entered pertaining to David Shannon appears on the

‘Contacts’ Information Card; however, you still need to enter information on the
other company owner, Sheila Eldon. To do this, click the New button on the
‘Contacts’ Card. (There are 2 New buttons in this layout. Be sure to click the one
on the ‘Contacts’ Card. If you click on the New Functions Button, you will be
asking to create a new customer. If this happens, Click Cancel in the dialog box
and return to the ‘Contact’ Profile).

Clicking the New button takes you to the Contact Profile. Each contact within a company
has his or her own unique contact information that can be entered on the ‘Phone’, ‘Ad-
dresses’ and ‘Other’ cards. The number at the top, “2 of 2” indicates you are viewing the
second of two contacts for ‘ABC Signing Service’.
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2. Enter ‘Ms. Sheila Eldon, Vice President, 555-7772’ in the applicable fields on

the ‘Phone’ card. Since Sheila also works from her home, you also want to enter
her home phone number. Click on the empty field below the word Fax. When the
pop-up menu appears, select Home and type ‘777-1234’.

3. Click on the ‘Addresses’ Card and enter Sheila’s email address of
‘sheilashannon@home.net’. If your contact had a mailing address other than the
main company address, it would be entered on the ‘Addresses’ card. If you enter
an address on the card it will supercede your company address for the contact.

4. Go Back to the Company Profile by clicking on the arrow icon at the bottom
left of the screen.

The Marketing Card
1. Click on the ‘Marketing’ card to make the ‘Marketing’ Index card active.
2. Most of the fields within this screen contain predetermined pop up lists. Enter the

following information:
• Account Manager ‘Russ’
• Contact Type ‘Client’
• Priority ‘High’
• Industry ‘Signing Service’
• Referral Source ‘Notary-services.com’

It is important that in the Contact Type you indicate that ‘ABC Signing Service’ is a
Client and not a Prospect or Supplier. Organizer Pro will only allow those Contact
Types who are designated as a ‘Client’ to enter billing or create an invoice. Although
your database indicates you have a total of 13 records (see the number in the upper right
corner), all of these records are actually active clients. If a Prospect becomes a Client
you can always return to the ‘Marketing’ Card and amend the Contact Type.

The Notes Card
1. Click on the word Notes to make the Notes Index card active.
2. You’ll notice the word Notes, on the upper left side of the card is underlined.

Click on it. Organizer Pro automatically enters  today’s date and a name.

Note that the name that is indicated when you click on the underlined date is not our
fictitious company notary, Russ. The name reflects the name of the person who was
initially specified in the sharing set up control panel of your computer. Therefore in some
instances during our Guided Tour, this name will appear instead of our fictitious com-
pany president.

3. Position the cursor to start your notes. Enter the text, ‘Met with Sheila and
David. Presented a proposal for Mobile Notary Services.
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Notice that the title Notes now has an asterisk* beside the word. This acts as a prompt
when you are in the Company Profile to remind you that you have entered notes in that
field.

The Signing Order Card (Project_USR)
Entering Signing Orders and Billing Entries, to be discussed in a later section.

The To Do Card
Mobile Notary Services  is a large and extremely busy firm. As the company Owner you
realize the importance of following up with clients and prospective clients on a regular
and timely basis. You use Organizer Pro’s To Do List to ensure that you remember to
call Sheila.

1. Click on the ‘TO DO’ card and click the New button, on left side of the ‘TO DO’
card.

2. Enter your name, Russ, from the pop up list under , ‘Who’.
3. Since you wish to call Sheila later today, enter today’s date (M/D/Y) or click on

the words ‘To Do Date’ to automatically paste today’s date.
4. From the ‘Activity’ field select ‘Phone Call’ from the Pop Up List
5. You determine that this phone call is extremely important so you select ‘A’ for

the priority of this task.
6. ‘Description’ is underlined, so by clicking on that word, today’s date and a

preset name will automatically appear. In the Description field type, ‘Call Sheila
with complete pricing for all cities that we offer our notary services and email or
fax this list to her’.

Having returned from a quick lunch break you decide to see all the clients you must
contact or correspond with. Click on the ‘To Do’ card and the first line item that you put
in.

7. Click on the Find All  Button to find “all” the tasks in your To Do List. The Total
Records found is 2 and is indicated near the top of the screen.

8. To see a list of all found records, click on the List button in the bottom left hand
side of the layout.

9. Locate and select the To Do Item for ‘ABC Signing Service’ to see a full descrip-
tion of the task, ‘Call Sheila with complete pricing for all cities that we offer our
notary services and email or fax this list to her’.

10. Click on the Return Arrow icon on the top right of the screen  to return to the
Company Profile for ‘ABC Signing Service’.

Congratulations you have successfully entered your first client on Organizer Pro.
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Finding Client Information
You are trying to locate a client file and the only information you remember about this
particular customer is that they operate their business out of the city of Franklin.

1. Click on the Find function button. A dialog box will appear that allows you to
search for one client or several clients that match the same ‘find’ criteria.

2. Enter ‘Franklin’ in the city field and click on the OK button or press the ‘enter’
key.

ORGANIZER PRO automatically locates and presents a ‘Company List’ of all clients
whose files contain the word ‘Franklin’. In our database there are 2 matching records.

3. At the bottom of the Company List layout locate and click on the button named
Find All . ORGANIZER PRO lists all the clients in your database.

4. Click on the title bar called ‘Company Name’. The database sorts these records
in alphabetical order.

5. Locate the company named ‘Centurion Documents’ in the Company List & click
once in the box to the left of the company name to Mark that record with an X.
Locate the company named ‘Foxboro Signing Services’ and Mark that record as
well.

6. At the bottom of the Client List layout locate and click on the button named
Marked . The system finds all the records you have marked. In this case, there
are 2  marked records in your list.

5. Click in the middle of the line with the name ‘Centurion Documents’. The Com-
pany Profile for ‘Centurion Documents’ becomes active.

Deleting Client Records
Having just found out that The Centurion Documents has moved to a city on the other
side of the country. We have found that its best not to delete the file from your database.

1. In the address field of the client, type in “moved to new location”. This lets you
know that the account has been re-input with a new address. You can put a
‘Note’ down on the ‘Note Card’ and a ‘To Do’ on the ‘To Do Card’ that you
need to get new information on for the client and re-input a new record.

2. To return to ‘ABC Signing Service’, perform a Find by clicking on the Find
Function button and typing a portion of the name ‘Signing’ and then Enter.

There are 5 records in our database matching your find criteria . A Find can be accom-
plished by entering full or partial information.

3. Click on the middle of the clients name to return to the Client Profile for ‘ABC
Signing Service’.
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Writing a Letter
At ‘Mobile Notary Services’ you send a letter to all your new clients after your first
meeting with them. You are ready to send a letter to the Owner of ‘ABC Signing Service’.

1. You currently have 2 contacts for the company ‘ABC Signing Service’ but you
wish to write the letter to the Owner, David Shannon. Locate the name of your
contact, David Shannon. Click anywhere on that line. ORGANIZER PRO opens
up the Contact Profile for David Shannon.

2. Click on the Letter  Button. A Dialog Box appears asking,
 “Do you want to print a letter for this contact or all the found contacts...”
It is important that in this instance you click the button for “This Contact” to
ensure that only one letter is produced for this contact, David Shannon.
If you select “All Found” a letter will be produced for both “Found”
records, in this case David Shannon and Sheila Eldon.

If you had performed a Find of all contacts in “Los Angeles” from the ‘Contact Profile’
layout, selected one of these contacts and then asked for a letter to be written to “All
Found”, a letter would be produced for each contact in Los Angeles. In other words, the
Found Set. The number at the top of the Client Profile under the Total Records indicates
the Found Set ( ie. 1 of 3, 2 of 6 etc).

3. If you haven’t already done so, Click on the button, “This Contact”. This brings
you to a screen called “Creating a New Letter...”

The client information for David Shannon has been pasted at the top of this new letter.
The buttons on the left side of the screen contain proforma or boiler plate letters that you
would use on a regular basis. (ie Introduction,  Follow up, Telephone Follow Up,  Refer-
ral etc). Once these letters are created and saved, they can be recalled and edited, if
necessary, for any client.

4. From the Letters Menu, click on the letter icon titled ‘Follow- up’.
5. In the field beside the red numeral 2,  type the words “Our Services and Pricing”.
6. Next to the red numeral 3, click OK.
7. The proforma letter that appears requires only one amendment. Highlight the

word DATE on the first line of the letter and type today’s date. Later in the body
copy find YOUR COMPANY NAME and input your company. At the closing of
the letter find YOUR NAME AND YOUR TITLE and complete. The letter can
be checked for ‘Spelling’ by clicking that word in the menu at the top of the
page.
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8. From the Menu, click on the icon for ‘Print’. A dialog box appears. Click on

“This Letter’. Once your letter is previewed, click on “Continue’ to view the
Print dialog box. Print your letter.

You could also print an envelope for this client by selecting the Envelope icon at the top
of the page.

Creating your own Proforma Letters
You decide it’s a great idea sending clients a letter confirming your upcoming meetings
with them. The friendly reminder ensures that you won’t be wasting time waiting for a
client who has forgotten to write down the appointment. Having a proforma letter in
place will save you rewriting the letter each time you need to send it.

1. From the Letters Menu at the top of the LETTERS_.USR file, select the “Edit
Form” icon at top.

2. From the “Editing a Letter...” screen, click the yellow “ed” to the right of the
blank button (just below the letter named ‘Notary Pay’)

3. Type the words “Meeting Confirmation” and then click outside the button.
4. Click on the name of the new letter, “Meeting Confirmation”. Notice the title

above the letter is now “Meeting Confirmation”.
5. Click on the letter area to edit it. Type the following,

This letter is to confirm our meeting of July 1st at 10 A.M. I look forward to the
opportunity to speak with you at that time.

Yours Truly,

Russell Miller.

Select the ‘Go Back’ button to return to the “Editing a Letter...” screen. Click the
‘Done’ button.

In the future each time you select the “Meeting Confirmation” button you will return to
that proforma letter. Amending the date and time of the meeting will provide you with a
custom letter for any particular client.

Congratulations, you have created your first proforma letter and, are no doubt, on your
way to a far more efficient and productive office.
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Adding a New Notary

If you are not currently in the Company Profile layout, return there by selecting
Company_.USR from the Window Menu bar at the top of the screen.

1.  Under the Functions (on the right of the screen), Click the New Button. This opens a
pop-up window that asks you, “Are you entering a new Company or Individual?”  You
want to select “Individual”.

2.  When entering the information for the New Notary, why not go ahead and put in your
own information. Salutation first then tab to, first name, last name and continue to tab and
input the notaries information. When you input for “Contact Type”  you want to put in
OUTSIDE CONTRACTOR and for “Catagory” put in NOTARY. You also can input a
“Base Fee” if the notary has a standard fee that he or she charges.

3.  You need to understand that the Company Profile is used for clients and client
contacts as well as for individuals that are notaries or other ‘Catagory’ types. We input
“Russell Miller” and “Kathy Miller”(for these two entries we used ‘Other’ for
‘Catagory’),the owners of “Mobile Notary Services”, because they do most of the docu-
ment signing for the company. We also entered“George Watson” whom they use when
they have more signing than they can handle. George isn’t employed by them, but is an
outside notary that they pay on a per signing basis.

4.  If you go to the Contact Card after entering a notary and Click on the notary name
line, this takes you to the Contact Profile layout. You can enter other pertinent informa-
tion about that notary under the Notary Info Tab .

Adding a New Signing Order  (Project_.USR)
It’s time to start inputing Signing Orders for your new client, ‘ABC Signing Service’ and
other clients in the Company Profile. In order to start you must set up a New Signing
Order.

If you are not currently in the Company Profile layout, return there by selecting
‘COMPANY_.USR’ from the Window Menu bar at the top of the screen.

1.  Go to the button Find All  and click. This finds all the companies in the Company
Profile. Next, go to the List  Button, just below ‘Home’ button and click on it. This brings
up a complete list of the companies you have entered. ‘ABC Signing Service’ will be at
the bottom of this list. Click on the Company/Name Title, which will sort the list and
bring ‘ABC Signing Service’ to the top of the list.  Click in the field line for ‘ABC Signing
Service’ and this will open to the Company Profile for this company. Go to the Informa-
tion Cards on the bottom of your layout and click on the Signing Order tab to open the
Signing Order Card.
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2.  Click the New button which is located on the top left side of the Signing Order card.
This opens the Signing Order Profile in the Project_.USR layout.  ORGANIZER PRO
assigns each new project a unique number which can be seen at the top left corner of this
screen. The ‘Status’ field automatically shows the order is ‘Open’  and the ‘Order Date’
indicates ‘Today’s Date’. You are ready to enter information for your signing with ‘ABC
Signing Service’.

3.  Your cursor will  be flashing in the Borrower field. Type ‘Collins, Howard G. and
Julie Anne’. Continue to tab to Address, City, State, Zip and Phone numbers. Input 5689
S. Monroe Street, Corona, CA 92880. Then 909-566-2588 for the home phone.

4.  In the ‘Loan No.’ field enter ‘68745213’ this give you a reference number for the
signing order.

5.  Tab forward to the ‘PO No.’ field and enter the PO Number, which comes from the
signing service if they give you one. In this example they haven’t provided a PO Number.
The ‘Source’ field is for the lender or mortgage company name ( you can add company
names to this field by selecting ‘edit’  in the field), ‘Co Rep’ is for the contact person from
‘ABC Signing Service’ and ‘Loan Rep’ for the Loan Officer. You can ‘edit’ the ‘Co Rep’
field. You again can enter your ficticous information in these fields. Tab again to go to
the ‘Notary ID’ field.

6.  You have the ability to get a notary for this order from the Company Profile, but first
you should know that if only one or two of you are doing the signing work for ‘Mobile
Notary Services’, you will probably remember the three digit number for each notary. To
get a notary, you will see the word ‘Get’ to the left of the ‘Notary ID’ field. Click on the
‘Get’  and it takes you to the Contact Profile layout. The cursor will be blinking in the
‘Last Name’ field. Enter the last name of the notary you want for this signing order. Type
in ‘Miller’  and click on the Continue button on the left side of the Contact screen. This
will find three records, Susan Miller (President of Centurion Documents), Russell Miller
and Kathy Miller, owners of this fictious company. Go up to the navigation arrows at the
top right of the screen and click on the third arrow from the left, to select each record.
When you get to ‘Kathy Miller’ , go to the Continue button on the left side of the screen,
but before you click on the button, notice the Notary ID number under the information for
‘Kathy Miller’ . This is her Notary ID number. Now click the Continue button and this
takes you back to the Signing Order Profile. The ‘Notary ID’, ‘Notary Name’ and ‘No-
tary Tel’ are automatically completed for you. If a base fee had been put in this notary
record, it would also be automatically completed (these are the fields in blue).

7.  Next, click on the ‘Company’ field and select ‘Unpaid’ from the pop-up menu. This
field tells you if this Signing Order is ‘Unpaid or Paid’ by ‘ABC Signing Service’.
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8.  After selecting ‘Unpaid’, move to the ‘Assign’ field. Type in the date the order was
given to you either by telephone, fax or e-mail. Type 1-30 or 1/30 and the program will
extend the date to 1-30-02 (you need to type the year for the ‘Guided Tour’). Next is
‘Appoint’ field, which is the appointment date given on the order. If none, you will be
calling the borrowers for a date and time for the appointment that is convenient for them.
Typically ASAP is the norm, so let’s put in 2-1-02 for the appointment date in the ‘Ap-
point’ field. The ‘Time’ field is the next to enter, with either the assigned appointment
time or a time you have set with the borrower(s). Enter the time as 3pm and be sure to use
‘am or pm’.  After you confirm a date and time, you can go to the ‘Conf’ field (Confirma-
tion) and select ‘Yes’ from the pop-up menu.

9.  Move to the ‘Billable’ field and type the payment amount given to you by ‘ABC
Signing Service’ for the Signing Order. The amount that was given was $50.00. You can
enter this as ‘50’ and the program will complete this for you.

10.  Tab to the ‘DTB’  field (Documents to Borrowers). If the documents are going to the
borrowers, then you need to be sure to tell the borrowers when you call them, to call you
when they receive the documents.

11.  The next three fields are completed when the documents arrive. The fields are ‘Doc
Arrival’, ‘Note Date’ and ‘Tracking No’. The date that you receive the documents is the
date for the ‘Doc Arrival’ . The date on the “Note”  for the loan is input into the ‘Note
Date’ and the Tracking Number from the return envelope is typed into the ‘Tracking No’
field. After you have completed these fields, go to the ‘Order’ button to print out the
Signing Order for this borrower. The Signing Order is used to write your directions to the
signing as well as taking it with you to the signing for reference.

12. After the signing is completed you enter the date signed in the ‘Signed’ field. Next
select the ‘Status’ field and change it from ‘Open’ to ‘Pending’. You do this for each
completed signing order, which transfers the signing order to the pending order section
for billing.

You have successfully completed a Signing Order!
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Lists, Reports and Forms

1.  The ’List’  button is located on the right side of the screen under ‘Layouts’. Click the
‘List’  button and this will take you to a screen called ‘Signing Order List’. At the bottom
of the screen are buttons for navigating to other areas. Click on the ‘Find All’ button and
this gives you all of your orders. Next click on the ‘Open’ button, which lists only the
open signing orders. Now, go up to the top of the screen and click on the ‘Appt’ heading.
This will sort the ‘Open’ signing orders by date. You will see your ‘ABC Signing Service’
order on this list. At a glance you can see that the documents haven’t arrived as yet,
because the ‘Docs’ field isn’t completed and that the appointment has been confirmed
with a ‘Yes’. The last signing order on the list is for ‘Document Signers’, which shows it
was probably a pre-set date and time order, but it has ‘No’ in the ‘Conf’ field, showing
that the borrowers haven’t been called  as yet to confirm the appointment. If you have
called and borrowers and you are only able to leave a message, you can enter’LM’ .

2.  Next, go to the bottom of the screen and click on the ‘Find All’  button, then go to the
top of the screen and you will see the ‘Company’ button. Click on it and it will take you
to another screen called ‘Company Billable’. You again can see at first glance, the ‘No-
tary Name’ and the ‘City’ where the signing is to take place. The other noticeable field is
‘Billable’, which gives you the amout to be billed for each signing order. At the bottom
of the screen you have a running total for the open signing orders. One other important
field is the ‘Stamps’ field. You can keep track of how many times you use your notary
stamp on each set of documents that you notorize. The other important field is the ‘Mile-
age’ field, which keeps track of your round trip mileage for each signing. This also gives
you a total at the bottom of the screen. You can see both of these fields and their totals.
Other ‘Stutus’ buttons at the bottom of the screen will give totals for their list too. For
instance ‘Pending’, ‘Complete’ or ‘Invoiced’.

3.  After looking at the ‘Company Billable’ you’ll want to click the ‘List’  button at the top
of the screen. This takes you back to the ‘Signing Order List’ screen. Click this time on
the ‘Notary’ button and you will arrive at the ‘Notary Payable’ screen. Go to the ‘Find
All’  button to find all the orders that you used an outside notary for the signing. If you
have been operating this business for a long time, you wouldn’t use this method to find
what is payable to your outside notaries. You will learn more about this in the “Notary
User Manual”, which is available at our web site.

4.  Click on the signing order line item for ‘Collins’. This takes you back to the ‘Signing
Order’ Profile screen. You have printable ‘Reports’, ‘Voucher’ and ‘Order’ forms, that
you can find by going to the ‘Print’ button area on the lower right side of the screen. You
can go ahead and look at them and print them if you like. More detailed information
about these is in the “Notary User Manual” .
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There are five Information Cards on the bottom half of the Signing Order Profile screen;
Billing, Invoiced, Work To Do, Outstanding and Notes.

Information Cards

1. Click on the tab named, “Work To Do”.
2. Click on the blue underlined words, Work To Do to enter today’s date.

Enter the following description of the work to be done;
“Need to call borrowers to let them know of money due escrow and a cashiers
check is required by  the Title Company.”
An asterisk appears beside the tab indicating you have entered information on
this card.

3. Click on the tab named, “Notes”. On this card you could enter any notes about
the signing order.

4. The “Outstanding” tab allows you to enter any notes about tasks that are out-
standing and need to be completed.

5. We will go to the “Billing” and “Invoiced” tabs later in the Guided Tour.

The Calendar (Planner.USR)
The Calendar is an added  feature of the Organizer Pro for notaries program.

1. It can be accessed by clicking on the calendar icon on most screens. Its location
varies from screen to screen.

The Calendar is very useful for your day to day scheduling of appointments and times for
those appointments. We have found that we use it for not only the appointment date and
time, but for the location of the signing and who gave us the signing order.

2. So let’s click on the ‘Calendar Icon’ between the two input areas on the ‘Signing
Order’ Profile screen.This takes you to the ‘Daily Planner’.

3. You now see the ‘Daily Planner’, which will be at today’s date. Click on the
button for ‘Daily View’.

4. The NOTES section in the center is the first place we want to add the ‘Topic’
note for your ‘Client List’. Click on the ‘A Note About Notes’ field. This gives
you a pop-up list of the ‘Topic’ notes. Hit the ‘delete’ key and type ‘Client List’,
then hit the ‘enter’ key. Use your mouse to ‘click’  in the open retangular space
below the new list title. Now, type the  list of clients of ‘Mobile Notary Services’.
See screen shot on page 27 for reference. You now have a list of clients with
reference numbers for your daily scheduling.
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5.   Go to the small monthly calendar and select (using the arrows) the month of
February, and the 1st day. This takes you to FRIDAY, FEBRUARY 1, 2002. The
signing order for ‘Collins’  is on this date. In the SCHEDULE, select the first box
in the first column, select ‘3pm’ and type in the column to the right the city you
put them in for the signing. Then hit the space bar twice and type the number ‘1’
for ‘ABC Signing Service’. You have just started your scheduling for the date
2/1/02. You can also include the borrower(s) last name if you want to, which
would then be, ‘borrower last name’, ‘city’ and number ‘1’.
6.   This DAILY PLANNER  template has lots of other very useful information
and is great for your personal planning and scheduling. On the ‘Menu’ page go to
the’i’  in the upper left corner of the screen and click  on it for a “Read Me’ file.
7.  To go back to the ‘Signing Order’ profile screen, which is behind the ‘Planner’
screen, just click on the background that’s visible around the ‘Planner’. Now your
back at the ‘Signing Order’ profile.

The Client Billing Process

We need to look at how and why we us the ‘Status’ field on the ‘Signing Order’ profile
screen. In this pop-up field you can select from; Open, Pending, Complete, Cancelled or
Invoiced.

1.  ‘Open’ status means that this signing order is yet to be completed.
2.  ‘Pending’ status means that this order is signed and is pending to be billed.
3.  ‘Complete’ status is used when you are about to go through the billing process
and you change the signing orders from’Pending’ to ‘Complete’ and mark all to be
billed with an ‘X’.
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4.  ‘Cancelled’ means an order is on hold or cancelled. Sometimes these orders
do become active again and you can retrieve them from the cancelled file and
change them back to the ‘Open’ status.
5.  ‘Invoiced’ means that the signing order is complete and has been processed
through the billing system. These orders go into the ‘Archive’ file.

This gives you a better understanding of the use of the ‘Status’ field and how by looking
at the field you can see what is going on for that particular signing order.

The ‘Paid List’ Button

During the month you sometimes receive payment on signings that you have completed
in that month. When you receive these checks, you should make a copy of the check and
retain it for that particular clients record or file. In the ‘Signing Order’ profile for this
signing you need to change the ‘Company’ field from ‘Unpaid’ to ‘Paid’. You do this
for all signings covered by that check. Be sure you have entered all checks, you have
received for the month before going on to the ‘Paid List’ report.
1. Before you start the billing process at the end of the month, go to the ‘Paid List’
button. You will get a pop-up screen that tells you to type ‘Paid’  in the first field. Next
tab to the ‘Signed’ field. Type the month in as shown, 2-1-02...2-28-02, which gives you
the month of FEBRUARY 2002 for all paid checks. Click on the ‘OK’ button to bring
up a paid list.
2.  This list is all the payments you received for the month from your clients. Go to the
‘Continue’ button and print the list. This list is used as a checks and balance for the final
confirmation of what’s been paid for the month. Use this list and your copies of checks
to comfirm what’s been paid against the invoices you are about to complete.

This is a ficticous Billing Process we are starting, so let’s go to the ‘find’ button and in
the pop-up screen go to the ‘status’ field, select ‘Open’, click the ‘OK’ button. The list
for ‘Open’ orders has 4 records in the found set. Click in the first record to go to the
‘Signing Order’ profile screen. Go ahead and complete these signing orders;
1.  The first one is ‘Smith’- input 2-10 in the ‘Signed’ field, change the ‘Status’ field
from ‘Open’ to ‘Pending’. Complete the ‘Stamp(s)’ field by inputing 5, which shows you
had 5 notary stamps on the loan documents for this signing.
2.  Go up to the arrows and go to the next record by chicking the right arrow (second
from the right). Repeat the steps above for ‘Yullman’. 2-11, Open status to Pending, 3
stamps.
3.  Next record is for ‘Land’, 2-16, Open to Pending, 4 stamps and in the ‘Conf’ field
select ‘Yes’.
4.  Finally for the last record ‘Collins’. 2-1, Open to Pending, 3 stamps. Go to ‘Doc
Arrival’, type in 1-31, ‘Note Date’, type in 2-1 and ‘Tracking No, type in 134675346.
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Now we can start the actual Billing Process. Normally, in your day to day work, you
would have been changing the ‘Status’ field from Open to Pending. Therefore the group
to be billed would be found under ‘Pending’ orders. We again have a ficticous group, so
we have to make some special changes at this time.
1. We are in the ‘Signing Order’ profile screen. Click  the ‘List’ button under the
Layout buttons on the right of the screen and click ‘List’. You will see a list of 4 pending
orders. Click the ‘Find All’ button at the bottom of the screen. This gives you a list of 16
records in this found set.
2.  Notice the square boxes at the far left of each record. Click in the boxes next to all
records for ‘Pending or Complete’. This puts an ‘X’ in each box. At the bottom of the
screen find the ‘Marked’ button and click on it. This found set has 10 records. Each
record that is ‘Pending’, change them to ‘Complete’. This is a pop-up menu so just
select ‘Complete’. Next go up to the ‘Appt Date’ heading and click on it. This will sort
the found set of 10 records by the appointment date. You now should have a list of 10
‘Complete’ orders.

3.  Click in the first record area and you will go to the ‘Signing Order’ profile screen.
This order is for the borrowers “Collins”.  We are going to start the billing with them.
You have two options to choose from. On the ‘Billing’ information card you see a
‘New’ button. Another ‘New’ button for ‘Billing’  is found on the top right side of the
screen just under the arrows and the heading “Billing”.  I use the latter because it is
more convenient when you are doing a lot of billing, but both button do the same thing.
4.  Before you click on the billing ‘New’ button you need to remember three things on
the signing order for “Collins” . First the ‘Signed Date’, next ‘Notary Name’ and then
the ‘Billable’  amount. Take a look at them, then click the ‘New’ button.
5.  You are now in a new screen called the ‘Billing Entry’ . The pop-up for ‘Notary
Name’ is ready for you to select ‘Kathy’. Tab to the ‘Date’ field and type in ‘2-1’ . Tab
again to the ‘Signing’ field and input ‘1’ for one signing. Tab to the ‘Billable’  field and
from the pop-up menu select ‘$50.00’. Tab again and you go to the ‘Problem Signing’
field. This space is used to denote a NO SIGN or NO SHOW, etc.. Click the “Back
Arrow” in the upper right side of the window. It’s round and just above the yellow
calendar icon. This takes you back to the ‘Signing Order’ profile.
6.  Check your input to be sure the information on the ‘Billing Information Card’ is
correct. If a mistake is found, click on the ‘Billing’  record (first line) of the ‘Billing
Information Card’ and make your corrections. If all is correct go to the next record by
clicking on the second arrow from the right in the upper right corner of the screen.
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7.  Your next record is for “Blacksmith” , which is already completed.
8.  The next is “Williams”  and it is complete as well. But you do need to make a
change in the ‘Billable’  field. Look at the amount in the ‘Billing Information Card’, it
shows $65.00 total because of a $15.00 charge for a copy set that was made for the
borrowers. The ‘Billable’  field only has $50.00 so change this to $65.00. The amounts
in the ‘Billable’  field and in the total on the ‘Billing Information Card’ must be the
same.
9.  Your next record for “Hamilton” is completed for you. Again we look at the
‘Billable’  field, which is $65.00 and the ‘Billing Information Card’ is $100.00 total.
This time the additional amount charged was for e-mail loan documents and copies that
were made for the borrowers. Change the ‘Billable’  field to reflect the $100.00.
10.  “Kindred” and “Burrows” are completed.
11.  “Smith” is next and needs to be completed. ‘Russell’, ‘2-10’, ‘1’ and $50.00.
12.  “Villanova” is completed.
13.  “Yullman”  needs to be completed. ‘Kathy’, ‘2-11’, ‘1’ and $50.00.
14.  “Land”  needs completion. ‘Russell’, ‘2-16’, ‘1’ and $50.00.
Look at the lower left corner of the ‘Signing Order’ profile screen and you will see the
words, ‘Amount Billable Total’ and after it $630.00. This is the total about to be billed.
Click on the list button, which takes you to the ‘Signing Order’ list. Click on the Com-
pany button on the top right, above the list of clients. Now look at the bottom right
corner of this list to see $630.00 with ‘Total Billable’ under it. These two totals must be
the same before completing the Billing Process. You also can see the total of 37 with
‘Total Stamps’ under it. This is the total stamps for the 10 signing orders. Click on the
‘List’  button at the top of the screen. This takes you back to the ‘Signing Order’ list.

You are now ready for the final step in the Billing Process. You have 10 records in the
list. At the bottom of the list screen, click on the ‘Billing’  Button. The following ‘Note’
appears:
“You are about to begin the billing process. Make sure you have marked all the projects
you wish to bill. Click OK to continue or Cancel to abort”. Click OK.

The ‘Client Billing Report’ screen is now visible. You can click on the small rolodex in
the upper left corner of the screen and scroll through the 10 signing order you are about
to print. Go to the ‘Continue’ Button to print these ‘Client Billing Reports’.
After these reports have been printed the program automatically converts these signing
orders to ‘Invoiced’ in the ‘Status’ field. Hand sort these sheets by client name.

You are ready to Invoice these Signing Orders!
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6.  Select ‘Upon Funding’ as the Terms of payment. This automatically completes the
Due Date of this invoice.
7.  In the Attention field enter the name of the person whose attention this invoice will
be sent. In our case, enter the name David Shannon.
8.  Using your printed ‘Client Billing Report’, enter the following information on your
Invoice Entry for work completed and to be invoiced for ‘ABC Signing Service’:

• 1 in the Quantity field
• Set of Loan Documents signed for:  in the Description field (Pop-up menu)
• Collins 2/1/02 in the Borrowers Name(s) and Signing Date field
• 50.00 in the Unit Cost field and press Tab.

You can use the Client Billing Reports as a reference to generate your Invoices for your
signings for each Client. When entering information on the Invoice Entry keep in mind
that a copy of the Client Billing Report can be included with your invoice to provide a
detailed description of the work completed.  Multiple signing can go on to one invoice.
Organizer Pro automatically calculates the amount, and give you the end total for this
invoice.

You can go ahead and complete all the invoicing for the ‘Client Billing Reports’ you
have printed.

Invoicing the Client
It is important to note that in the User Version of Organizer Pro there is no ‘direct’ link
between the Billing Entries and Invoices modules.
1.  Select HOME.USR from the Window Menu and then select the ‘Invoices’ button to
view the Invoice Entry screen.
2.  Click on the New Function Button.
3.  A find dialog box named ‘New Invoice Entry’ opens and a pop-up list appears of all
clients (prospects are not included in this list). Locate and select ‘ABC Signing Service’
and click OK
4.  An Invoice Entry is created for your client with a unique incremental Invoice
Number. In the Ref # field, you could type ‘ a PO No’ to reflect the Purchase Order
Number, if you were provided one by the client.
5.  Click in the field for ‘Service Type’ to open a pop up list. Select ‘Notary Signing’
which reflects the work you have completed for ‘ABC Signing Service’.
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Printing Invoices
When printing invoices, you have 2 options; printing one at a time or all invoices at once.

To Print One Invoice at a time;

1.  From the Invoice Entry layout, select the Reports Button named Invoice. The invoice
for ‘ABC Signing Service’ is displayed. Click on the Continue button, and print your
invoice. Notice your company name, ‘Mobile Notary Services’ appears at the top of the
invoice.

If you had many invoices you might choose to ‘Print All Invoices at one time’ by selecting
the Reports Button named Menu and then All Invoices Not Yet Printed. However we
have chosen the first option.

Receiving Payments

Be sure to use your ‘Paid List’ that you printed which is your list  of all checks received
before you started your billing process at the end of the month. You can now use
this’Paid List’ to input into the ‘Payment Entry’ screen. You click on the ‘Payment’
button on the right side of the ‘Invoice Entry’ screen, under ‘Layouts’.

At ‘Mobile Notary Services’ you have the ideal business environment. Within one week
a check arrives for $50.00 from ‘ABC Signing Service’ for payment of your invoice.

1.  If you are not currently viewing the Invoice Entry layout, Select Invoices_.USR from
the Window Menu.
2.  Click on the Payment Button in the Invoice Entry layout to view the Payment Entry
screen.
3.  The Payment Entry screen shows that ‘Shannon and Associates’ have an outstand-
ing Invoice for the amount of $50.00.
4.  Enter the Check No. as 777.
5.  Click on the underlined words, Payment Date to automatically enter today’s date.
6.  Since this is a full payment, click on the underlined words Payment Amount to enter
the full invoice payment amount. Tab out of the field.

The Balance Due has changed to show a ‘Zero’ balance.

Receiving payments is the best part of your job. You decide to end your busy day at
‘Mobile Notary Services’ on that pleasant note.

Congratulations you have successfully finished the Guided Tour.


